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Chapter 497

Confidence Intervals
for Paired Means with
Tolerance Probability
Introduction
This routine calculates the sample size necessary to achieve a specified distance from the paired sample mean
difference to the confidence limit(s) with a given tolerance probability at a stated confidence level for a
confidence interval about a single mean difference when the underlying data distribution is normal.

Technical Details
For a paired sample mean difference from a normal distribution with unknown variance, a two-sided, 100(1 –
α)% confidence interval is calculated by

X Diff ±

t1−α / 2 ,n −1σˆ Diff
n

where X Diff is the mean of the paired differences of the sample, and σ diff is the known standard deviation of
paired sample differences.
A one-sided 100(1 – α)% upper confidence limit is calculated by

X Diff +

t1−α ,n −1σˆ Diff
n

Similarly, the one-sided 100(1 – α)% lower confidence limit is

X Diff −

t1−α ,n −1σˆ Diff
n

Each confidence interval is calculated using an estimate of the mean difference plus and/or minus a quantity that
represents the distance from the mean difference to the edge of the interval. For two-sided confidence intervals,
this distance is sometimes called the precision, margin of error, or half-width. We will label this distance, D.
The basic equation for determining sample size when D has been specified is

D=

t1−α / 2 ,n −1σˆ Diff
n
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Solving for n, we obtain

 t1−α / 2 ,n −1σˆ Diff
n = 
D






2

This equation can be solved for any of the unknown quantities in terms of the others. The value α/2 is replaced by

α when a one-sided interval is used.

There is an additional subtlety that arises when the standard deviation is to be chosen for estimating sample size.
The sample sizes determined from the formula above produce confidence intervals with the specified widths only
when the future sample has a sample standard deviation of differences that is no greater than the value specified.
As an example, suppose that 15 pairs of individuals are sampled in a pilot study, and a standard deviation estimate
of 3.5 is obtained from the sample. The purpose of a later study is to estimate the mean difference within 10 units.
Suppose further that the sample size needed is calculated to be 57 pairs using the formula above with 3.5 as the
estimate for the standard deviation. The sample of size 57 pairs is then obtained from the population, but the
standard deviation of the 57 paired differences turns out to be 3.9 rather than 3.5. The confidence interval is
computed and the distance from the mean difference to the confidence limits is greater than 10 units.
This example illustrates the need for an adjustment to adjust the sample size such that the distance from the mean
difference to the confidence limits will be below the specified value with known probability.
Such an adjustment for situations where a previous sample is used to estimate the standard deviation is derived by
Harris, Horvitz, and Mood (1948) and discussed in Zar (1984) and Hahn and Meeker (1991). The adjustment is

 t1−α / 2 ,n −1σˆ Diff
n = 
D


2


 F1−γ ;n −1,m −1


where 1 – γ is the probability that the distance from the mean difference to the confidence limit(s) will be below
the specified value, and m is the sample size in the previous paired sample that was used to estimate the standard
deviation.
The corresponding adjustment when no previous sample is available is discussed in Kupper and Hafner (1989)
and Hahn and Meeker (1991). The adjustment in this case is

 t1−α / 2 ,n −1σˆ Diff
n = 
D






2

 χ12−γ ,n −1 


 n −1 



where, again, 1 – γ is the probability that the distance from the mean difference to the confidence limit(s) will be
below the specified value.
Each of these adjustments accounts for the variability in a future estimate of the standard deviation. In the first
adjustment formula (Harris, Horvitz, and Mood, 1948), the distribution of the standard deviation is based on the
estimate from a previous paired sample. In the second adjustment formula, the distribution of the standard
deviation is based on a specified value that is assumed to be the population standard deviation of differences.
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Finite Population Size
The above calculations assume that samples are being drawn from a large (infinite) population. When the
population is of finite size (N), an adjustment must be made. The adjustment reduces the standard deviation as
follows:




σ finite = σ 1 −

n

N

This new standard deviation replaces the regular standard deviation in the above formulas.

Confidence Level
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are drawn from a
population using simple random sampling and a confidence interval is calculated for each sample, the proportion
of those intervals that will include the true population mean difference is 1 – α.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters.

One-Sided or Two-Sided Interval
Interval Type
Specify whether the interval to be used will be a one-sided or a two-sided confidence interval.

Population
Population Size
This is the number of pairs in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made. This option sets the population size.
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Confidence and Tolerance
Confidence Level (1 – Alpha)
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are drawn from a
population using simple random sampling and a confidence interval is calculated for each sample, the proportion of
those intervals that will include the true population mean difference is 1 – α.
Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90 0.95 0.99 or
0.90 to 0.99 by 0.01.
Tolerance Probability
This is the probability that a future interval with sample size N and the specified confidence level will have a
distance from the mean paired difference to the limit(s) that is less than or equal to the distance specified.
If a tolerance probability is not used, as in the 'Confidence Intervals for Paired Means' procedure, the sample size is
calculated for the expected distance from the mean paired difference to the limit(s), which assumes that the future
standard deviation will also be the one specified.
Using a tolerance probability implies that the standard deviation of the future sample will not be known in advance,
and therefore, an adjustment is made to the sample size formula to account for the variability in the standard
deviation. Use of a tolerance probability is similar to using an upper bound for the standard deviation in the
'Confidence Intervals for Paired Means' procedure.
Values between 0 and 1 can be entered. The choice of the tolerance probability depends upon how important it is
that the distance from the interval limit(s) to the mean difference is at most the value specified.
You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.95 by 0.05.

Sample Size (Number of Pairs)
N (Sample Size or Number of Pairs)
Enter one or more values for the sample size. This is the number of pairs selected at random from the population
to be in the study.
You can enter a single value or a range of values.

Precision
Distance from Mean Difference to Limit(s)
This is the distance from the confidence limit(s) to the mean paired difference. For two-sided intervals, it is also
known as the precision, half-width, or margin of error.
You can enter a single value or a list of values. The value(s) must be greater than zero.
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Standard Deviation of Paired Differences
Standard Deviation Source
This procedure permits two sources for estimates of the standard deviation of paired differences:
•

S is a Population Standard Deviation
This option should be selected if there is no previous sample that can be used to obtain an estimate of the
standard deviation of the paired differences. In this case, the algorithm assumes that future sample obtained
will be from a population with standard deviation S.

•

S from a Previous Sample
This option should be selected if the estimate of the standard deviation of the paired differences is obtained
from a previous random sample from the same distribution as the one to be sampled. The sample size of the
previous sample must also be entered under 'Sample Size of Previous Sample'.

Standard Deviation of Paired Differences– S is a
Population Standard Deviation
S (Standard Deviation)
Enter an estimate of the standard deviation of paired differences (must be positive). In this case, the algorithm
assumes that future samples obtained will be from a population with standard deviation S.
One common method for estimating the standard deviation is the range divided by 4, 5, or 6.
You can enter a range of values such as 1 2 3 or 1 to 10 by 1.
Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.

Standard Deviation of Paired Differences – S from
a Previous Sample
S (SD Estimated from a Previous Sample)
Enter an estimate of the standard deviation of paired differences from a previous (or pilot) study. This value must
be positive.
A range of values may be entered.
Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.
Sample Size (# of Pairs) of Previous Sample
Enter the sample size (number of pairs) that was used to estimate the standard deviation entered in S (SD
Estimated from a Previous Sample).
This value is entered only when 'Standard Deviation Source:' is set to 'S from a Previous Sample'.
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Example 1 – Calculating Sample Size
A researcher would like to estimate the mean difference in weight following a specific diet with 95% confidence.
It is very important that the mean difference is estimated within 5 lbs. Data available from a previous study are
used to provide an estimate of the standard deviation. The estimate of the standard deviation of before/after
differences is 16.7 lbs, from a sample of size 17 individuals.
The goal is to determine the sample size necessary to obtain a two-sided confidence interval such that the mean
weight is estimated within 5 lbs. Tolerance probabilities of 0.70 to 0.95 will be examined.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Confidence Intervals for Paired Means with Tolerance Probability procedure window by
expanding Means, then expanding Paired Means, then clicking on Confidence Interval, and then clicking on
Confidence Intervals for Paired Means with Tolerance Probability. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Interval Type ........................................... Two-Sided
Population Size ....................................... Infinite
Confidence Level .................................... 0.95
Tolerance Probability .............................. 0.70 to 0.95 by 0.05
Distance from Mean Diff to Limit(s) ........ 5
Standard Deviation Source ..................... S from a Previous Sample
S.............................................................. 16.7
Sample Size of Previous Sample ........... 17

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided Confidence Intervals

Confidence
Level
0.95
0.95
0.95
0.95
0.95
0.95

Sample
Size
(N)
58
61
66
71
79
92

Target
Dist from
Mean Diff
to Limits
5.000
5.000
5.000
5.000
5.000
5.000

Actual
Dist from
Mean Diff
to Limits
4.970
4.996
4.967
4.985
4.973
4.981

Standard
Deviation
(S)
16.700
16.700
16.700
16.700
16.700
16.700

Tolerance
Probability
0.70
0.75
0.80
0.85
0.90
0.95

Sample size for estimate of S from previous paired sample = 17.
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Report Definitions
Confidence level is the proportion of confidence intervals (constructed with this same confidence level,
sample size, etc.) that would contain the population mean difference.
N is the size of the sample (or number of pairs) drawn from the population.
Dist from Mean Diff to Limit is the distance from the confidence limit(s) to the mean paired difference. For
two-sided intervals, it is also know as the precision, half-width, or margin of error.
Target Dist from Mean Diff to Limit is the value of the distance that is entered into the procedure.
Actual Dist from Mean Diff to Limit is the value of the distance that is obtained from the procedure.
The standard deviation (S) is the standard deviation of the paired differences.
Tolerance Probability is the probability that a future interval with sample size N and corresponding
confidence level will have a distance from the mean difference to the limit(s) that is less than or equal to
the specified distance.
Summary Statements
The probability is 0.70 that a sample size of 58 will produce a two-sided 95% confidence
interval with a distance from the mean paired difference to the limits that is less than or
equal to 4.970 if the population standard deviation is estimated to be 16.700 by a previous
paired sample of size 17.

This report shows the calculated sample size for each of the scenarios.

Plots Section

This plot shows the sample size versus the tolerance probability.
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Example 2 – Validation
This procedure uses the same mechanics as the Confidence Intervals for One Mean with Tolerance Probability
procedure. The validation of this procedure is given in Examples 2, 3, and 4 of the Confidence Intervals for One
Mean with Tolerance Probability procedure.
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